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Introduction: What is a Geospatial PDF? 
 
A geospatial PDF is a file format used to store and distribute geospatial information. Geospatial PDFs: 

 May contain multiple map layers – including geographic features and aerial imagery – that can 
be toggled on or off. 

 Have a known coordinate system, making it possible to determine exact geographic locations. 

 Can be viewed with standard PDF readers like Adobe Acrobat Reader. 

 Allow for length, perimeter and area calculation. 
 
Geospatial PDF is an extension of the standard PDF (Portable Document Format) file originally 
developed by Adobe Systems. This proprietary file format became an open standard in 2008, when the 
file specification was published by the International Organization for Standardization (ISO) as ISO 32000-
1:2008 (https://www.iso.org/standard/51502.html).  
 
Geospatial PDFs have a number of advantages over other geospatial data formats. 

 PDF is a familiar format used by millions of people. GIS software and experience is not needed 
to use geospatial PDFs. Software to read geospatial PDFs can be downloaded for free.  

 Functionality native to some PDF readers allows simple GIS-like functions to be performed, such 
as determining location and calculating lengths and areas.  

 PDFs were developed to provide device-independent high-end graphics capabilities. Geospatial 
PDFs can be used to distribute high-quality finished maps for on-screen viewing or printing.  

 There are some large collections of maps in geospatial PDF format, including the newest USGS 
topographic map series. 

 
Geospatial PDFs have some limitations. A geospatial PDF is a static snapshot of a geospatial dataset. The 
file must be regenerated when the underlying data is updated. As such geospatial PDFs are often used 
to visualize geospatial data and for simple types of user interaction such as marking locations and 
measuring distances. However, geospatial PDFs do not offer the functionality of a geospatial database. 
 

https://www.iso.org/standard/51502.html
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A “GeoPDF” is similar to but distinct from a geospatial PDF. A GeoPDF is a PDF extension developed and 
patented by TerraGo, a US-based geospatial company (http://www.terragotech.com/). GeoPDFs contain 
proprietary elements that allow the format to fully interact with TerraGo software. These software tools 
may not work the same way with standard geospatial PDFs.  
 

US Topos 
 
This technical paper provides an overview of geospatial PDFs and their basic features, focusing on US 
Geological Survey (USGS) “US Topos” as a case study. 
 
US Topos are digital topographic maps produced by the USGS and delivered digital format. They replace 
the USGS’s legacy paper topographic maps. US Topos support more frequent updating and broader 
public distribution of data and provide other advantages over traditional paper topographic maps. The 
term “US Topo” refers specifically to topographic maps published in 2009 and later that are mass-
produced from national GIS databases on a repeating cycle (https://www.usgs.gov/core-science-
systems/national-geospatial-program/us-topo-maps-america). 
 
Note that the the USGS transitioned the format of US Topos to geospatial PDF in 2017. Previously, US 
Topo maps were published in TerraGo’s “GeoPDF” format (https://pubs.usgs.gov/tm/tm11b2/). 
 
US Topos:  

 provide nation-wide coverage using consistent symbolization 

 have the same format and scale as the legacy 7.5-minute USGS paper maps “quads” 

 contain layers that can be turned on and off to customize the map 

 contain an orthophoto (rectified aerial photograph) base that can be turned on and off 

 are updated on a three year cycle 

 are based on authoritative, best-available source data 

 can be downloaded for free from the web 

 can be printed from a personal computer (the whole map or a selected area) 

 are in the public domain with no copyright restrictions or license fees 

 can be viewed using free software 

 do not require GIS software or expertise to utilize 
 

For a comprehensive description of the US Topo product see Davis, L.R., Fishburn, K.A., Lestinsky, 
Helmut, Moore, L.R., and Walter, J.L., 2019, US Topo Product Standard (ver. 2.0, February 2019) 
(https://doi.org/10.3133/tm11b2). 
 

Historic USGS topographic maps that were originally published in paper form are also available on the 
web. These maps have been scanned and converted to digital format and are available for free. To view 
and download these maps visit http://historicalmaps.arcgis.com/usgs/ or 

https://ngmdb.usgs.gov/topoview/. 
 

http://www.terragotech.com/
https://www.usgs.gov/core-science-systems/national-geospatial-program/us-topo-maps-america
https://www.usgs.gov/core-science-systems/national-geospatial-program/us-topo-maps-america
https://pubs.usgs.gov/tm/tm11b2/
https://doi.org/10.3133/tm11b2
http://historicalmaps.arcgis.com/usgs/
https://ngmdb.usgs.gov/topoview/
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Obtaining US Topos 
 
To access US Topos you can visit the USGS National Map Data Delivery page at 
https://www.usgs.gov/core-science-systems/ngp/tnm-delivery/topographic-maps. 
 
Click on the Launch button to launch the app: 
 

 
National Map Data Delivery webpage 

 
When the app opens, you will see a view similar to the screenshot on the next page. You can choose 
which US Topo products you want to search for (area labeled on the screenshot with a “1”), including 
both the most current edition and earlier “non-current” editions. 
 
You can also chose to search for the older paper topographic maps, which can be downloaded in digital 
format (area labeled with a “2”). While these older maps are available, they should only be used for 
users whose interests are primarily historical. Many of these maps are decades out-of-date; for the most 
current data the most recent US Topo should be used. 
 
You can search for an area of interest in different ways, including drawing a bounding box or a point, or 
entering an address or place name (area labelled with a “3”). You can also select different map series, 
such as the 1:24,000 map series and others. 
 

https://www.usgs.gov/core-science-systems/ngp/tnm-delivery/topographic-maps
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Map view and search functions 

 
In the example below, the address/place name search has been used to search for the city of Stoughton, 
Wisconsin. 
 

 
Address/Place search 
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The map display now zooms to Stoughton, as shown below. 
 

 
Location found! 

 
You can now click on the Find Products link (highlight 1 below) to generate a list of US Topos found at 
this location. To download a US Topo click on the Download link (highlight 2 below). In this example, 
only one US Topo is found because the box for the most current US Topo was checked. For this location 
the most current US Topo was published on 11/19/2018. 
 

 
Downloading a US Topo 

 
After clicking on the Download link a PDF file will be downloaded to your computer. Sizes vary but 
expect the file to be tens of MB (megabytes) in size. 
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Using Geospatial PDFs in a PDF Reader 
 
Adobe Acrobat Reader is one of the most widely used PDF readers and can be used for US Topos and 
other geospatial PDFs. There are many alternatives to Acrobat Reader but not all of these alternatives 
are able to make use of the geographical information encoded in geospatial PDFs.  
 
Acrobat Reader is available for free from https://acrobat.adobe.com/us/en/acrobat/pdf-reader.html. 
Once this software is installed, you can open a geospatial PDF by simply double-clicking on it. The image 
below is a screenshot similar to what you will see when your map opens. (The screenshots in this 
document use the 11/19/2018 Stoughton map, and reflect Acrobat Reader DC Version 2019.012.20036.) 
 

 
US Topo in Acrobat Reader (1 of 2) 

 
PDF menus are in the upper left of the window (highlight area 1). Page controls are in the toolbar at the 
top (highlight area 2). The layer tool, which we will come back to later, is at highlight area 3. PDF Reader 
tools are in the right panel (highlight area 4). The map itself is displayed in the document window 
(highlight area 5). Actually, only the top half of the map is shown. Using the scroll bar (highlight area 6 
on the screenshot below) you can scroll to the bottom of the map. The map collar (highlight area 7) will 
now be visible. It contains information on map scale, data sources used, projection and datum, magnetic 
declination, and map symbology. A more complete legend can be found at https://edrnet.com/wp-
content/uploads/2014/08/US-Topo-Map-Symbols.pdf 

https://acrobat.adobe.com/us/en/acrobat/pdf-reader.html
https://edrnet.com/wp-content/uploads/2014/08/US-Topo-Map-Symbols.pdf
https://edrnet.com/wp-content/uploads/2014/08/US-Topo-Map-Symbols.pdf
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US Topo map in Acrobat Reader (2 of 2) 

 
One of the most useful features of US Topos is that map layers can be turned on and off to customize 
the map for your particular purposes. To work with layers, first click on the layer tool (labeled “1” on the 
screenshot below). Layers can be expanded or collapsed by clicking on the appropriate arrows (labeled 
“2”). Layers can be turned on and off by clicking on the eye icon (labeled “3”). 
 

 
Working with map layers 
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You can create highly customized maps by manipulating layers. For example, the screenshot below 
shows the Stoughton map with most features turned off, but with shaded relief and an aerial image 
turned on. 
 

 
A customized US Topo 

 
You can use the pan and zoom tools in Acrobat Reader to zoom in and out of the map and pan to 
different areas.  
 

 
Pan and zoom controls 
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To access measuring tools choose the Tools tab in the upper left (location “1” on the screenshot below) 
or More Tools (location “2”). 
 

 
Accessing measuring tools 

 
Next, choose the Measure option. 

 

 
Measure tools 
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A new toolbar will now appear at the top of the window. (See yellow arrow below.) 
 

 
Tools toolbar 

 
Click on the Geospatial Location Tool (see screenshot below) to dynamically display the cursor location 
(latitude and longitude) as you move across the map.  
 

 
Geospatial Location Tool 
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Click on the Measuring Tool (see screenshot below) to compute lengths, perimeters and areas. Choose 
length, perimeter, or area from the appropriate icons under Measurement Types. Then, draw the shape 
you want to measure and the results will be displayed. 
 
To measure distance, click on your starting point and then your ending point. To measure perimeter, 
click on a corner point of the object you are measuring, click on the next corner point, continue doing 
this around the object, and double-click to finish. To measure area, click on a corner point of the object 
you are measuring, click on the next corner point, continue doing this around the object, and then click 
the first point to finish. 
 
The Snap Types options allow you to define the drawing environment for your shapes. For example, 
clicking the Snap to Paths icon (the first of the icons under Snap Types) will cause new points that you 
draw to snap to a nearby line (path).  
 

 
Measurement Tool 
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To change the format of the location or measurement, choose Preferences from the Edit menu, and 
then choose Measuring (Geo) from the Categories list. You can change the latitude-longitude format 
from Decimal to Degrees, Minutes, Seconds. And you can change the units for distance and area 
measurements too. (See screenshot below.) 
 

 
Geographic measurement preferences 

 

Making Prints and Digital Copies 
 
Acrobat Reader tools can be used to print US Topos or portions of them. To print or save a portion of a 
geospatial PDF, zoom in to the area of interest, and then select Print under the File menu. In the Print 
dialog box, you will need to choose More Options and select Current View or else Acrobat Reader will 
print the entire map. (See screenshot below.) You can also choose the page size, orientation and other 
features just as you would with an ordinary PDF.  
 

 
Printing a portion of a map 
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To save a digital copy rather than print a copy, simply choose Adobe PDF in the Printer drop down list 
rather than an actual printer name, and click Print. This will save the selected portion of the map to a 
new PDF file. You will be prompted for a filename and location. Note that the resulting file will be a 
standard PDF, not a geospatial PDF. You will not be able to turn layers on and off (the file will have been 
flattened) and georeferencing information will have been discarded. 
   

The Advantages of Geospatial PDFs and US Topos 
 
Geospatial PDFs have many advantages, including portability, quality of map rendering, ease of printing, 
and ease of use. Geospatial PDFs can be viewed using free software that is familiar to millions of users. 
For these reasons, geospatial PDFs support the broader adoption of digital geospatial technology, 
especially by individuals with little or no GIS experience. The end result is that geospatial information 
can more readily be integrated into existing workflows and operations.  
 
US Topos offer many advantages over earlier USGS paper topographic maps. You can work with layers, 
turning them off and on to create a custom map. You can easily measure locations, lengths, perimeters 
and areas. You can print the whole map, or a portion of it, on a color printer. You can save a portion of a 
map as a stand-alone PDF. US Topos can also be incorporated into GIS as base layers. US Topos are free 
to use and reflect the most up-to-date information available. If you are still using the older USGS paper 
topographic maps, now is the time to make the switch. 
 
 
 


